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Renesas Synergy™ プラットフォーム 

高度な GUIX™アプリケーション例 

本資料は英語版を翻訳した参考資料です。内容に相違がある場合には英語版を優先します。資料によっては

英語版のバージョンが更新され、内容が変わっている場合があります。日本語版は、参考用としてご使用の

うえ、最新および正式な内容については英語版のドキュメントを参照ください。 

 

 

要旨（Intraduction） 

このアプリケーションノートでは、Express Logic GUIX™ Studio と Renesas Synergy™ GUIX モジュールの活

用方法について説明しています。アプリケーションプロジェクトの完了後、ユーザは自身の設計に対して 

Synergy GUIX モジュールの追加やアプリケーションに合わせた正しい設定、そして付属するサンプルア

プリケーションコードを参考にしてコード開発を始めることができます。API の詳細説明や他のアプリ

ケーション例は、参考資料の章に記載された Renesas Synergy Knowledge Base に基本から高度な使用方法

まで記されており、より複雑な設計を行うときの貴重な情報になります。 

このアプリケーションノートでは、GUIX 機能を応用して、以下のような洗濯機アプリケーション (Washing 

Machine application) 向けの高機能 GUI を作成する方法を段階的に説明しています。 

 ウィジェット（widget）の作成 

 メイン画面内での複数の画面の作成 

 画面を切り替え時の子画面の接続と切離し画面乱れをおこさないためのダブルバッファトグル制御

（Double-buffer toggling control） 

 円形スライダ、垂直スライダ、水平スライダの作成 

 アニメーションの表示 
 

またこの資料では、Synergy GUIX アプリケーションを作成のための以下の設計ガイドラインや検討すべき

事項も掲載しています。 

 Synergy MCU 内に搭載されたハードウェアエンジン（JPEG コーデック、2D 描画エンジン）の活用方法 

 Synergy GUIX に必要なフラッシュメモリと RAM のサイズ 

 RAM/SDRAM が使用する画面サイズ依存のフレームバッファについて 

 内蔵フラッシュメモリと外部フラッシュメモリへの画像の保存方法 

 タッチ制御フレームワーク（touch conrtol framework）と I2C フレームワーク（I2C framework）の組み合わせ
によるタッチインタフェースについて 

 

必須リソース（Required Resources） 

Synergy GUIX のサンプルアプリケーションをビルドおよび実行するには、次のリソースが必要です。 

開発ツールとソフトウェア（Development tools and software） 

e2 studio ISDE v6.2.0 またはそれ以降(renesassynergy.com/e2studio)、あるいは 

IAR Embedded Workbench® for Renesas Synergy™ v8.2 またはそれ以降 (renesassynergy.com/ewsyn) 

 Synergy ソフトウェアパッケージ (SSP) 1.4.0 またはそれ以降 (renesassynergy.com/ssp)、 

 Synergy Standalone Configurator (SSC) 6.2.0 またはそれ以降 (renesassynergy.com/ssc) 

 SEGGER J-Link® および関連 USB ドライバ (renesassynergy.com/jlink) 

 GUIX Studio v5.4.0 またはそれ以降 (renesassynergy.com/guix-studio) 
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ハードウェア（Hardware） 

 Renesas Synergy™ PE-HMI1 キット バージョン 2.0 またはそれ以降 (renesassynergy.com/pe-hmi1) 

 Windows® 7 または 10 が動作している PC 

 Mini USB ケーブル 
 

前提条件と対象読者（Prerequisites and Intended Audience） 

このアプリケーションノートは、ユーザが Synergy e2 studio ISDE か、Renesas Synergy に対応する IAR 

Embedded Workbench のいずれか、および Synergy ソフトウェアパッケージ (SSP) の使用経験があることを

前提に説明しています。このアプリケーションノートの手順を実行する前に、『SSP ユーザマニュアル』

(3.2 章 チュートリアル：Blinky の実行) の手順に従って Blinky プロジェクトをビルドし、実行してくださ

い。それにより、e2 studio と SSP の使用に慣れ、ボードへのデバッグ接続が適切に機能していることを確

認できます。 

一般的な GUI インタフェース、そのコンポーネント、および設計の原理について理解している必要がありま

す。配色、さまざまな画像形式、画像処理などに関するグラフィックスの基礎、および GUI の構成要素 

(ウィンドウ、メニュー、アイコン、ウィジェットなど) に関する基礎知識も必要となります。 

Synergy と GUIX を初めて使用する場合、次の資料に記載された GUIX 全般や、Synergy との統合方法につい

て理解する必要があります。これらの資料へのリンクは、「参考資料」を参照してください。 

 『GUIX™ Synergy Port Framework のモジュールガイド』 

英文タイトル：GUIX™ Synergy Port Framework Module Guide 

 PE-HMI1 用 GUIX™ Hello World アプリケーションプロジェクト 

英文タイトル：GUIX™ Hello World Application Project on PE-HMI1 
 

以下のドキュメントを参考資料として使用することもできます。 

 『SSP ユーザマニュアル』 

 『GUIX Studio User’s Guide』 

 『GUIX User’s Guide』 

 

 

 

 

 

 

 

 

 

 

 

  

http://renesassynergy.com/pe-hmi1
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1. GUIX の導入と GUIX Studio の概要（Getting started with GUIX and GUIX Studio 

Overview） 

GUIX Studio は、組み込みアプリケーション向け GUI の作成を目的とした、GUI アプリケーション設計ツール

と環境です。GUIX は、ターゲット MCU で GUI アプリケーションを実行させるための、Express Logic 社が提

供するミドルウェアソフトウェアライブラリです。Express Logic の GUIX Studio と GUIX Library の詳細は、本

資料の「参考資料」に記載されている『GUIX Studio User’s Guide』と『GUIX User’s Guide』に記載されていま

す。 

1.1 Synergy 向け GUIX アプリケーション開発検討（GUIX application design 

consideration for Synergy） 

Renesas S7 と S5 の Synergy MCU グループシリーズは、以下の機能を持つグラフィックス LCD 機能を搭載し

ています。 

 グラフィックス LCD コントローラ (GLCDC) 

 2D 描画エンジン (DRW) 

 JPEG コード 
 

1. メモリ要件に関する検討事項（Memory requirement considerations） 

A. RAM/ROM 要求（RAM/ROM requirement）：GUIX は、GUIX スレッド（GUIX thread）と他のグ

ローバルな構造体データ（Global data structures）のために、約 80 K バイトの ROM (読み出し専用

メモリ) と 10 K バイトの RAM を必要とします。これには、描画用のキャンバスメモリ（Canvas 

memory）やフレームバッファ（frame buffer）は含まれません。 

B. 内部フラッシュ / 外部フラッシュ（Internal Flash / External Flash）：大部分のアプリケーションで

は、GUIX のコアライブラリのストレージ要求（core GUIX library storage requirements）に含まれ

ないグラフィカルリソースも利用します。このリソースには、フォント、グラフィカルアイコン 

(ピクセルマップ pixelmaps)、固定の文字列があります。これらデータは、フラッシュ メモリの

ROM領域に配置します。コンパイルしたアプリケーションは、GUIX リソースイメージとともに

内部フラッシュに配置します。コードサイズが大きい場合は、外部フラッシュに配置することも

できます。メモリ領域のサイズは、使用するフォントの数やサイズ、グラフィカルアイコンの数

やサイズ、出力カラーデータに依存します。また、RLE圧縮（Run Length Encoding  compression）

もサポートしているためフォントやピクセルマップデータの圧縮にも依存します。各リソースの
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ストレージ要求は GUIX Studio アプリケーションの中で表示されるため、アプリケーションリ

ソースが消費するフラッシュメモリの量の追跡と監視に役立ちます。 

C. 内部 RAM / 外部 RAM に関する検討事項（Internal /External RAM considerations）：キャンバス

またはフレームバッファが使用するメモリサイズは、LCD ディスプレイのサイズ、色の深度、

画像の形式、画面の数などによって異なります。320 ピクセル * 256 ピクセルのような小型 LCD 

ディスプレイの場合、画像の形式や画面の色数にもよりますが、S7/S5 Synergy MCU グループシ

リーズの SRAM に格納できることがあります。800 ピクセル * 480 ピクセルのようなより大きい 

LCD ディスプレイの場合、「16 ビット RGB 565」(赤 5 ビット、緑 6 ビット、青 5 ビット) の画

像形式を使用すると、S7/S5 Synergy MCU ボードの SRAM に格納することはできません。この場

合、フレームバッファはボード上で利用可能な外部 RAM (SDRAM) 内に配置する必要がありま

す。フレームバッファのメモリ要件は、フレームサイズと色深度の関数で表され、次の式で定義

することができます。 

フレームバッファの RAM (バイト) = (x * y * (bpp/8)) 

ここで、「x」と「y」は、キャンバス (ディスプレイ) の横と縦のピクセル数、 bpp は 1 ピクセル

のビット数です。 

例えば、サイズが 800 *480 で 16 ビット RGB 565 を使用しているディスプレイに対応するフレー

ムバッファのサイズは、 (800 * 480) * 16/8 = 768,000 バイトと計算します。 
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D. JPEG ワークバッファに関する検討事項（JPEG Work buffer considerations）：JPEG のワーク

バッファに関して、JPEG のデコード速度とバッファサイズはトレードオフの関係にあります。

画面のウィジェットが JPEG 形式になっている場合、JPEG のワークバッファは、デコード後の画

像を作成するための一時的なストレージメモリとして使用されます。画像全体をデコードするう

えでバッファサイズが十分な大きさではない場合、JPEG のデコードは出力バッファを使用した

ストリーミングモード（output buffer streaming mode）で実行されます。 

2D 描画エンジンが使用する BitBLT 演算は、バッファ内で JPEG ラスタ画像（raster image）の一

部をデコードし、次にフレームバッファに転送します。JPEG 作業バッファの最小サイズは {(水

平ライン内のピクセル数) x (表示形式に対応する bpp (バイト数/ピクセル)) x 8 (ライン数)} です。 

例えば、デコード後の画像が水平ライン内で 800 ピクセルの幅で、RGB565 形式を使用している

場合、この値は 800 x 2 x 8 = 12,800 バイトになります。バッファサイズがこの値より小さい場

合、JPEG のデコードは処理されません。 

スループット（throughput）を改善するには、Size of the JPEG Work Buffer (JPRG ワークバッファ

のサイズ) パラメータをより大きい値に設定する必要があります。その結果、 JPEG デコードの

スループットが向上します。JPEG 出力バッファのストリーミングモードを繰り返して、部分的

な JPEG のデコードを繰り返すため、オーバーヘッドが発生します。 

E. ソフトウェアレンダリングとハードウェアレンダリングの比較（Software Rendering vs 

Hardware Rendering）：ソフトウェアレンダリングと比較すると、ハードウェアレンダリングの

方が高性能です。ただしこの性能を実現するためには、ハードウェアエンジンのために追加バッ

ファが必要になり、メモリに制約のあるシステムではこの点を考慮する必要があります。 

F. 画面の回転（Screen Rotation）：GUIX モジュールは、90、180、270 度の画面の回転をサポート

しています。画面の回転機能を使用するには、GUIX はフレームバッファ以外のメモリ (キャン

バスバッファ Canvas buffer) を必要とします。 
 

2. SSP フレームワークのインタフェース（SSP Framework interface） 

SSP は、GUIX 用の ISDE 設定の一部として、以下のフレームワークと HAL ドライバを（HAL drivers）

提供しています。GUIX アプリケーションを設計する際に、以下の SSP コンポーネントを活用すること

ができます。SSP タッチパネルフレームワークを使用する場合、メッセージングフレームワーク、I2C 

ドライバ、タッチドライバなどの関係するコンポーネントも含まれます。LCD のバックライトを駆動す

る PWM ドライバを使用することもできます。 

 タッチパネルフレームワークインタフェース（Touch Panel Framework Interface） 

 メッセージングフレームワーク（Messaging Framework） 

 I2C ドライバ（I2C driver） 

 タッチドライバ（Touch driver） 

 PWM ドライバ（PWM driver） 
 

3. ピン設定（Pin configurations） 

SSP は、GLCD 周辺回路ピン（GLCD Peripheral pins）、GPIO ピン（GPIO pins）、タイマ関連ピン

（Timer related pins）など、各種ピンを設定するためのピンコンフィグレータ（Pin configurator）を提供し

ます。GUIX アプリケーションを設計する場合、ピンコンフィギュレータを使用してピンを設定してく

ださい。タッチインタフェースを搭載した LCD パネル（LCD panel with touch interface）を使用する場

合、以下のピン設定が必要です。 

 GLCDC 周辺回路ピン設定（GLCDC Peripheral pin configuration） 

 PWM ピン設定（PWM Pin configuration） 

 割り込みピン設定（Interrupt Pin configuration） 

 I2C ピン設定（I2C Pin configuration） 

 リセットピンなどの LCD 制御ピン（LCD Control pins such as, Reset Pins） 
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4. 性能に関する検討事項（Performance considerations） 

 外部フラッシュ / 内部フラッシュ（External Flash / Internal Flash）：アプリケーションの性能は、アプ
リケーションや GUI のイメージを保存する場所に左右されます。アプリケーションと GUI のイメージ
は、内部フラッシュに保存する方が性能は良好です。 

 内部 RAM / 外部 RAM に関する検討事項（Internal /External RAM considerations）：外部 RAM 

(SDRAM) と比較し、内部 RAM (SRAM) を使用する方が性能は良好です。メイン画面の中で画面を更新
するアプリケーションや、それに対応するメモリレイアウトを SRAMに配置するように選択することが
できます。 

 色深度（Color Depth）：色深度の高いアプリケーションより、色深度の低いアプリケーションの方が性
能は良好です。24 bpp や 32 bpp の画像形式と比較し、8 bpp や 16 bpp の方が性能は良好です。 

 ディスプレイの解像度（Display Resolution:）：より高解像度の LCD ディスプレイの場合、ソフトウェ
アレンダリングの場合と比較し、ハードウェアエンジンを使用する方が高性能となります。 

 ソフトウェアレンダリングとハードウェアレンダリング（Software/Hardware rendering）：GUIX は 

JPEG と 2D の描画エンジン（JPEG and 2D Drawing Engine）をサポートしており、グラフィックスのレ
ンダリングとアクセラレーション機能を使用することで GUI の性能が向上します。これらのハード
ウェアモジュールは、CPU の介在なしにフレームバッファへの書き込み処理することができます。
GUIX は、ハードウェアエンジンが使用できない場合に、ソフトウェアレンダリングをサポートしてい
ます。この場合、フレームバッファはソフトウェアによって全面的に制御されます。ソフトウェアレン
ダリングは、フレームバッファが小さい小型ディスプレイや、MCU のバンド幅利用率が高くないアプ
リケーションに適しています。ただし大型の LCD ディスプレイでソフトウェアレンダリングを使用す
ると、性能が問題になる可能性があります。 

 

2. GUIX モジュールの API 概要（GUIX Module APIs Overview） 

以下に、GUIX モジュールで使用可能な API を示します。これらの API は、Synergy GUIX フレームワークモ

ジュールの汎用 API（Synergy GUIX Framework Module Generic APIs）と、GUIX 固有 API（GUIX Specific 

APIs）に大別することができます。 

GUIX フレームワークモジュールの API（GUIX Framework Module APIs） 

以下の API は Synergy GUIX モジュールの一部であり、ロウレベルグラフィックスドライバの設定とキャン

バスメモリの初期化に使用されます。これら API の詳細は、『SSP ユーザマニュアル』(5.1.27 章 GUIX 

Synergy Port Framework Module) を参照してください。 

表 1   GUIX フレームワークモジュールの API（GUIX Framework Module APIs） 

open 標準的な SSP に準拠する API であり、SF_EL_GX モジュールを開き、ロウレベルグ
ラフィックスデバイスドライバとフレームバッファを設定する目的で使用します。 

close SF_EL_GX モジュールと、ロウレベルドライバを閉じます。 

versionGet モジュールのバージョンを返します。 

setup ロウレベルグラフィックスデバイスドライバを初期化するためのインタフェースで
あり、GUIX (Studio) サービスコール gx_studio_display_configure() を通じ
て、関数ポインタ（function pointer）の形で GUIX に渡す必要があります。 

次に GUIX は API をコールバックし、このときこの API は open によって渡された
設定に基づいて SSP デバイスドライバを設定します。 

canvasInit GUIX のヘルパー API （helper API）であり、GUIX キャンバスのメモリアドレスを
決定します。この API は、(GX_WINDOW_ROOT *) 型の引数を受け取り、GUIX に対
してキャンバスメモリの開始アドレスを渡します。このアドレスは、低水準グラ
フィックスドライバが画像の描画や表示を行うために必要とするものです。  

 

GUIX API：アプリケーションに対して、GUIX は豊富な API セットを提供します。ユーザが GUI アプリ

ケーションの開発で利用できる API が 500 種類以上あります。GUIX API のグループを以下に示します。

API の詳細な説明については、「GUIX User’s Guide」（日本語版：Guix ユーザーズマニュアル）の 5 章を

参照してください。 
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表 2   GUIX API の分類 

アニメーション
（Animation） 

アニメーションコンポーネント、その関数、サービス。任意のウィジェットタ
イプ（widget type）に対する、フェードイン（fading in）、フェードアウト

（fading out）、移動、またはスライド方式のアニメーション。 

ユーティリティ関数 

（Utility function） 

GUIX で一般的に使用できるユーティリティ関数。例：整数を ASCII に変換する
関数、平方根、サイン関数を計算する算術関数など。 

ウィンドウ 

（Window） 

ウィンドウ固有のコンポーネントとその関数。例：ウィンドウの作成、ウィン
ドウの描画、ウィンドウイベントの処理、ウィンドウスクロール情報の取得な
ど。 

描画 

（Drawing）  

GUIX が画面にあらゆる視覚的要素を描画するために必要とする基本的図形の描
画。 

ウィジェット関連 

（Widget related） 

ウィジェットの作成、ウィジェット境界の描画などを行う、ウィジェット関連
コンポーネントとその関数。 

ディスプレイ 

（Display） 

ディスプレイの作成、ディスプレイテーブル内での色の置換などを行う、ディ
スプレイ関連コンポーネントとその関数。 

キャンバス 

（Canvas） 

キャンバスコンポーネントに関連する処理を行うこれらの API は、キャンバス
の作成、キャンバスの非表示、キャンバスの表示などの処理に対応します。 

GUIX システム 

（GUIX System） 

システムの初期化、システム言語の設定、システムタイマの開始など、システ
ム固有の機能。 

 

GUIX API は、ヘッダファイル gx_api.h の中でも参照できます。 

 

3. GUIX ベースの洗濯機アプリケーションの例（GUIX Based Washing Machine 

Application Example） 

3.1 アプリケーションの概要（Application overview） 

このアプリケーションについて理解するには、アプリケーションのアーキテクチャと Synergy との統合方法

の理解から始める必要があります。また、このアプリケーションと SSP フレームワークやスレッドとの相互

作用についても理解する必要があります。 

図 1 に、SSP フレームワークと HAL ドライバに統合されている洗濯機アプリケーションのアーキテクチャ

の概要を示します。ここに示すアプリケーションスレッド (HMI スレッド HMI Thread) は、以下の機能を持

ちます。 

 GUIX とそのドライバの初期化 

 ディスプレイの設定 

 キャンバスの初期化 

 バックライト用 PWM ドライバの初期化 
 

タッチパネルフレームワークは、LCD 上のタッチコントローラを制御します。LCD 上のタッチパネルで発

生したタッチイベントを、I2C インタフェース経由で受信します。タッチパネルフレームワークはタッチイ

ベントを受信し、メッセージングフレームワークを使いそれに付随するスレッドにタッチイベントを送信し

ます。タッチイベントに紐づいた HMI スレッド(HMI Thread)は、タッチパネルフレームワークからタッチイ

ベントが返されるのを待ち、メッセージングフレームワークからイベントを取得します。 

HMI スレッドは、(GUIX フレームワークの一部として生成される) GUIX スレッドによる処理を進めるため

にタッチイベントを GUIX イベントに変換します。 

SF_EL_GX は GUIX が Synergy MCU ボードにアクセス行うレイヤであり、グラフィクスエンジンである 

GLCDC 、 DRW (2DG エンジン)、 JPEG デコードエンジンにもアクセスすることができます。 

SF_EL_GX には、以下のような主要な関数があります。 
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 GUIX を SSP フレームワークに適応させます。 

 SSP ディスプレイドライバインタフェースを GUIX ディスプレイドライバインタフェースに接続します。 

 Synergy 2D 描画エンジン（DRW）によるアクセラレーションを使用し、GUIX がウィジェットを描画で
きるようにします。 

 画面のちらつきを発生させないためのダブルバッファをトグル制御します。 
 

SSP、SF_EL_GX およびそれに関係する HAL に対する GUIX の実装方法は、『SSP ユーザマニュアル』

（SSP User’s Manual）に掲載されています。 

 

図 1   アーキテクチャの概要 
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3.2 GUIX アプリケーションの作成手順（Sequence of steps to create the GUIX 

application） 

以下に、GUIX アプリケーションを作成する際に必要となる開発のステップを示します。ステップ 1 と 4 は

本資料で説明していません。それ以外のステップは、この後の 3.4 章と 4 章で説明します。 

1. GUI 画面に対応するピクセルマップの画像を作成します。 

 一般的にこの作業は、グラフィックスデザイナーが担当します。これらの画像を GUIX Studio に入力

し、必要な複数の画面を作成します。 

2. GUIX Studio で GUI を作成します。 

GUIX Studio を起動し、プロジェクト用件に従ってさまざまな画面を作成します。 

3. リソースファイルを生成します。 

GUIX Studio を使用して画面を作成した後、ウィジェットとそのハンドラ関数は、アプリケーション

コードとともにコンパイルできる形式（C 言語プログラムコードや Ｃデータ構造）にする必要がありま

す。 

4. 画面イベントと画面描画のハンドラ関数に対応するコードを作成します。 

各画面には、それぞれイベントハンドラと描画ハンドラが存在します。プロジェクト要求に基づいてイ

ベントを処理し、画面を描画するコードを作成する必要があります。また他に、初期関数やユーティリ

ティ関数の作成も必要です。 

5. ISDE コンフィギュレータを使用して GUIX を SSP に実装します。 

アプリケーションスレッドを作成します。GUIX は SSP に統合されます。このプロジェクトで使用する 

LCD のタイプ、タッチコントローラ、グラフィックスエンジンの仕様に基づいて、ISDE コンフィギュ

レータを使って GUIX コンポーネントの追加と設定を行う必要があります。 

6. Synergy e2 studio ISDE を使用して GUIX アプリケーションコードを統合します。 

生成するリソースファイルに加えて、GUIX システムの初期化、GUIX ドライバの設定、キャンバスの初

期化、ウィジェット作成 API （widget creation API）を使用した画面の作成、GUIX の起動、タッチドラ

イバから受け取るタッチイベントの制御が必要になります。これらの作業はいずれも、アプリケーショ

ンスレッド (サンプルアプリケーションでは HMI スレッド) から実行します。 

7. コードをビルドします。コードを生成し、ターゲット MCU 向けにビルドします。 
 

3.3 洗濯機アプリケーション向け GUI の概要（Washing Machine application GUI 

overview） 

ここでは、洗濯機コントローラをアプリケーションの実例として説明しています。図 2 は、洗濯機コント

ローラを構成するグラフィックスデザインを示しています。以下のように、4 種類の画面に分類することが

できます。 

1. メイン画面 (洗濯機の設定画面 Washer Settings screen) 

2. 衣類選択画面 (Garments selection screen) 

3. 水位選択画面 (Water level selection screen) 

4. 温度選択画面 (Temperature selection screen) 
 

このアプリケーションは、GUI の視点から、洗濯機コントローラをシミュレーションします。 

メイン画面（Main screen）：メイン画面は洗濯機の制御機能を表示するもので、円形のスライダと、さま

ざまな画面の選択用ボタンや、画面の電源オン/オフ用ボタンがあります。 

制御機能（control configurations ）に加えて、以下の情報が表示されます。 

 Soak、Wash、Rinse、Spin (注水、洗濯、すすぎ、脱水) という状態を示すステータスバー。 

 洗濯サイクルの残り時間を示すステータスバー。 

 時刻と日付の情報。 
 

Garment (衣類) 選択画面：衣類の種類を選択するための画面で、円形のスライダと、さまざまな画面の選択

用ボタンや、画面の電源オン/オフ用ボタンがあります。 

制御機能に加えて、以下の情報が表示されます。 
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 Soak、Wash、Rinse、Spin (注水、洗濯、すすぎ、脱水) という洗濯の状態を示すステータスバー。 

 時刻と日付の情報。 
 

Water level (水位) 選択画面：水位を選択するための画面で、垂直スライダと、さまざまな画面の選択用ボ

タンや、画面の電源オン/オフ用ボタンがあります。 

加えて、以下の情報が表示されます。 

 洗濯槽に対する水位をパーセントで表示。 

 Soak、Wash、Rinse、Spin (注水、洗濯、すすぎ、脱水) という洗濯の状態を示すステータスバー。 

 時刻と日付の情報。 
 

Temperature (温度) 選択画面：水の温度を制御するための円形のスライダがあります。また、さまざまな画

面の選択用ボタンや、画面の電源オン/オフ用ボタンがあります。 

制御機能に加えて、以下の情報が表示されます。 

 現在の水温を示すステータスバー。 

 Soak、Wash、Rinse、Spin (注水、洗濯、すすぎ、脱水) という洗濯の状態を示すステータスバー。 

 時刻と日付の情報。 
 

 

図 2   洗濯機コントローラで使用する GUI の概要 
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以下の図は、メイン画面の詳細を示しています。 

1. Express Logic による、「GUIX」と「Express Logic」の各ロゴ 

2. 時刻、日付、カレンダーの情報 

3. ホームボタン 

4. 洗濯機のステータス 

5. さまざまな画面を選択するための制御ボタン 

6. 洗濯サイクルを表すステータスバー 

7. 洗濯機の制御ウィンドウ 

8. 洗濯の状態に関する情報を示す円形のスライダ 
 

 

図 3   洗濯機コントローラで使用する GUI の概要 

以下の章でも、図 3 に記された番号(1~8)の順序で GUIX Studio を使用したウィジェットの作成方法を解説し

ています。 

この章では、ユーザが GUIX や GUIX Studio の各ビューの基礎を理解し、本資料の巻末にある「参考資料」

に掲載した『GUIX Module Guides』ドキュメントを閲読した実績があることを前提に説明しています。まだ

この参考資料を読んでいない場合、まずこれらのドキュメントを参照することを推奨します。 

GUIX Studio を使用して GUI を作成する前に、グラフィックス画像と、.png (portable network graphics) 形式の

画像ファイルを GUIX Studio で使用できるようにする必要があります。これらの画像ファイルは、グラ

フィックスリソースへの入力として使用します。グラフィックス画像の作成と画像ファイルへの変換は、こ

のアプリケーションノートでは取り扱いません。グラフィックスデザイナーからこれらのファイルを受け取

ることを想定します。 

3.4 GUIX Studio を使用した洗濯機サンプルプロジェクトの作成（Washing machine 

example project creation using GUIX Studio） 

この章では、GUIX Studio を使用して洗濯機 GUI の作成方法を段階的に説明します。サンプルプロジェクト

を作成する前に、GUIX Studio の起動方法と、以下のようなさまざまなビュー(View)について理解しておく

ことを推奨します。ビューには、Project View (プロジェクトビュー)、Properties View (プロパティビュー)、
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Target View (ターゲットビュー)、Resources View (リソースビュー) (Color (カラー)、Fonts (フォント)、

Pixelmaps (ピクセルマップ)、文字列など)があります。これらは、本資料の「参考資料」に掲載されている

『GUIX Studio User’s Guide』の Chapter 3 と 4 で説明されています。これらドキュメントを参照しておくこと

で以下の説明に対する理解が容易になります。 

3.4.1 GUIX プロジェクトの新規作成（Create New GUIX project） 

GUIX Studio で、[Project] タブ -> [New Project] を選択します。次の図に示す[Create New Project] ウィンド

ウがポップアップ表示されます。 

 

図 4   新しいプロジェクトの作成 

[Project Name] と [Project Path] を入力します。Project Path は、プロジェクトファイル（project file）を配置

するディレクトリ（directory）を意味します。入力後、[Save] ボタンをクリックします。 
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[Save] ボタンをクリックすると、[Configure Project] ウィンドウが表示されます。このウィンドウには、プ

ロジェクトの初期設定のための多くの設定項目があります。以下の章で、これら設定項目の詳細と、変更方

法を説明します。 

注記：次の図で示すように、[Project Path] は GUIX Studio のインストール先と同じ場所を指定してくださ
い。 

 

図 5   新しい [Configure Project] ウィンドウ  

3.4.1.1 リソースファイルに対応するディレクトリの選択（Selecting the 

directories for the resource files） 

図 5 に示す [Configure Project] スナップショットの [Directories] 部 “1”では GUIX のソースファイルとヘッ

ダファイルが配置される選択可能なディレクトリを示しています。[Resource Files] ディレクトリも、GUIX 

Studio がリソースファイル(仕様ファイルが配置される)を生成したディレクトリであり、選択可能です。 
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プロジェクトにヘッダファイルを追加する場合、ハイライトされている [Additional Headers] 部 “3” で設定

することができます。 

注記：ワークスペース内では、アプリケーションのソースコードを配置するディレクトリを指定することを
推奨します。これにより、GUIX Studio で変更が行われたときに生成されたリソースファイルが、ビ
ルド用のプロジェクトから使用できるようになります。リソースファイルを手動でコピーする必要が
なくなります。 

 

3.4.1.2 ターゲット CPU とツールチェーンの選択（Selecting the target CPU and 

toolchain） 

GUIX Studio はさまざまな種類のターゲット CPU とツールチェーン “2” をサポートしています。デフォ

ルトで、Generic CPU (汎用 CPU) と Generic Tool chain (汎用ツールチェーン) をサポートします。加えて、

Renesas Synergy CPU と GNU/IAR ツールチェーンの組み合わせもサポートします。Renesas Synergy でア

プリケーションを開発するには、[CPU] として [Renesas Synergy] を選択し、 [Toolchain] として [GNU] か 

[IAR] を選択してください。このサンプルアプリケーションでは、[GNU] ツールチェーンを選択していま

す。 

3.4.1.3 ディスプレイ設定（Display configuration） 

GUIX プロジェクトのディスプレイ設定 “4” で、 プロジェクトが必要とするディスプレイの数を指定しま

す。[Display Number] を使用してこの値を設定できます。洗濯機アプリケーションの場合、ディスプレイの

数は 1 です。ディスプレイの名前を指定できます。洗濯機アプリケーションの場合、この 1 つのディスプレ

イが、メインディスプレイ（main display）となります。 

[GUIX Configuration] では、X と Y のピクセル解像度を設定します。ディスプレイの解像度には、800 * 480 

(PE-HMI1 ボードに搭載されている LCD の解像度) を選択しています。 

GUIX の設定で、ピクセルあたりのビット数 (bpp) を指定します。このサンプルでは、16 bpp を選択しまし

た。 

以下の項目の設定が可能です。 

 [grayscale] (グレースケール) 

 [invert polarity] (極性反転) 

 [reverse byte order] (バイト逆順) 

 [packed format] (パケットの形式) 

 [rotated orientation] (回転方向) 
 

また、プロジェクトの要件に応じて、さまざまな RGB 形式を選択できます。 

GUIX の設定を使用して、[Allocate Canvas memory] (キャンバスメモリの割り当て) を指定することができま

す。この設定項目は、Windows 環境に効果的でが、組み込みシステムの場合、このオプションは選択されて

いません。 
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3.4.1.4 詳細設定（Advanced settings） 

[Synergy Advanced Settings] を使用して、Synergy MCU グループの一部で使用できる機能を設定することがで

きます。[Runtime Image Decoder] (実行時の画像デコーダ) に対応する設定と、[2D Drawing Engine] (2D 描画エ

ンジン) を有効にするためのオプションを選択することができます。洗濯機アプリケーションでは、次の図

に示すように、[2D Drawing Engine] (2D 描画エンジン) を有効にし、[Hardware JPEG Decoder] (ハードウェア 

JPEG デコーダ) を選択しています。 

 

図 6   Synergy Advance Settings (Synergy の詳細設定) 

 

 

 

3.4.1.5 GUIX ライブラリのバージョン（GUIX Library version） 

この章で、GUIX ライブラリのバージョンを設定します。GUIX Studio と組み合わせて使用する SSP のバー

ジョンに合わせることを推奨します。GUIX Studio バージョン 5.4.0.0 で使用しているライブラリのバージョ

ンは 5.4.0 です。 
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3.4.1.6 設定完了後の GUIX プロジェクト（Configured project） 

次の図に、洗濯機アプリケーションで必要な設定を行ったプロジェクト示します。 

 

図 7   洗濯機プロジェクトの設定 

3.4.2 GUIX Studio リソースの追加（Adding GUIX Studio resources） 

GUIX Studio は、色 (colors)、フォント (fonts)、ピクセルマップ (pixel maps)、文字列 (strings)のようなリソー

スに対するインタフェースを提供します。この章では、ピクセルマップと色の各リソースを追加する方法を

説明しています。GUIX リソースの詳細については、 本資料の「参考資料」に掲載されている『GUIX Studio 

User’s Guide』の Chapter 4「GUIX Studio Resources」を参照してください。 

3.4.2.1 ピクセルマップリソースの追加（Adding Pixelmaps resources） 

ピクセルマップの追加とは、GUIX Studio を使用してプロジェクトにグラフィックスリソースを追加するこ

とを意味します。グラフィックスデザイナーから各画像に対応する個別の .png ファイルが提供されます。

GUIX Studio で、使用するピクセルマップリソースに対してこれらの画像を追加する必要があります。ピク

セルマップに関して、[System] ディレクトリと [Custom] ディレクトリを指定します。[System] ディレクトリ

は、標準的な画像の保存場所です。[Custom] ディレクトリは、カスタムデザインした画像の配置先であり、

画像をこのディレクトリにコピーする必要があります。 

GUIX Studio IDE の右側に、リソースセクションがあります。[Pixelmaps] をクリックして、次の図に示すよ

うに[Custom] フォルダを選択し、グレー表示されている [+ Add New Pixelmap] をクリックする方法により、

[Pixelmaps] -> [Custom] の [+ Add New Pixelmap] を選択することができます。 
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図 8   ピクセルマップリソースの追加 

 

ここで、画像ファイルを選択するためのウィンドウが開きます。GUIX Studio に画像ファイルをインポート

するためのディレクトリを指定します。以下の図は、ディレクトリを指定した後の表示の例です。 

 

図 9   選択した画像ファイルをピクセルマップリソースに追加 
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画像ファイルを GUIX Studio にインポートした後、次の図のように、GUIX Studio のリソースとして 、

[Custom] ピクセルマップの下にそれらのファイルが表示されます。 

  

図 10   追加したピクセルマップリソース 



Renesas Synergy™ プラットフォーム 高度な GUIX アプリケーション 

R11AN0299JU0100  Rev.1.00  Page 20 of 59 

2018.06.28  

3.4.2.2 色リソースの追加（Adding Colors resources） 

GUIX Studio が持つデフォルト色に加え、必要とする色をプロジェクトに追加することもできます。新しい

色をプロジェクトに追加するには、[Colors] の横の[+] 記号をクリックし、[+] (Add New Color、新しい色の追

加) を選択します。この結果、[Color Name] を選択するためのウィンドウがポップアップ表示され、RGB の

値を設定して最適な色を決定します。必要な色を決定した後、その色を保存します。洗濯機アプリケーショ

ンでは、新しい色が必要です。新しい色 (SILVERY、銀白色) を追加する例を次の図に示します。色を追加

した後は、GUIX Studio で設計する画面でそれらの色を使用できるようになります。 

 

図 11   新しい色リソースの追加 
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3.4.3 Project View を使用したメイン画面の作成（Creating the main screen under 

Project View） 

初期のプロジェクト設定が完了し、リソースファイルを GUIX Studio に追加した後、プロジェクトに必要な

さまざまなウィンドウ (画面) の作成が可能になります。次の図は、ディスプレイに新しいウィンドウを追加

する際のスナップショットです。最初の項目を右クリックし、[main_display] -> [Insert] -> [Window] -> 

[Window] を選択します。この結果、ディスプレイに新しいウィンドウが追加されます。 

 

 

図 12   ディスプレイへの新しいウィンドウの追加 
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3.4.3.1 プロパティビューを使用したウィンドウのプロパティの変更（Changing the 

window properties using Properties View） 

追加したウィンドウに対し、プロパティビューを使用してウィンドウのプロパティを変更することができま

す。デフォルトで作成されるウィンドウは、次の図に示すように親ウィンドウの半分のサイズです。 

 

図 13   新しいウィンドウのプロパティの変更 

洗濯機アプリケーションの場合、画面全体に表示されるようにウィンドウのサイズを変更する必要がありま

す。[Height] パラメータを 480、[Width] を 800、[Left] を 0、[Top] を 0 に変更することで実現します。さら

に、ウィンドウの色を変更する必要があります。洗濯機アプリケーションでは、ウィンドウの色を黒 (背景

色) にする必要があります。この色を変更するには、GUIX Studio の  [Resources] にある  [Color] 部で、

[WINDOW_FILL] (ウィンドウの塗りつぶし) 色を変更します。最初の項目を右クリック、[WINDOW_FILL] -

> [Edit Color] を選択した後、[Red]、[Green]、[Blue] の各値すべてに「0」を指定すると黒色になります。

[WINDOW_FILL] に変更を加えるサンプルのスナップショットを、次の図に示します。 
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図 14   ウィンドウの塗りつぶしに使用する色の編集 

次の図は、ウィンドウのプロパティである、[Left]、[Right]、[Top]、[Bottom] と [WINDOW_FILL] を変更した後

の状態を示しています。 

 

図 15   メイン画面の背景ウィンドウ 
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背景ウィンドウより手前に、洗濯機アプリケーションで使用するさまざまなウィジェットを追加する必要が

あります。 

 GUIX のロゴ 

 Express Logic のロゴ 

 時刻と日付の情報 

 ホームボタン 

 制御ボタン 
 

洗濯方法の選択肢を示す [Radial Slider] (円形のスライダ) ウィンドウと [Status] ウィンドウなども定義しま

す。 

3.4.3.2 メイン画面への  GUIX ロゴと  Synergy ロゴの追加（Adding GUIX and 

Synergy logo to the main screen） 

GUIX のロゴと Express Logic のロゴを画面に追加するには、ターゲットのウィンドウを右クリックし、

[Insert] -> [Button] -> [Icon] を選択します。この結果、次の図に示すように、アイコンウィジェットが画面に

追加されます。 

 

図 16   ウィンドウへのボタンアイコンの挿入 

 

 

 

 

 

 

 

 



Renesas Synergy™ プラットフォーム 高度な GUIX アプリケーション 

R11AN0299JU0100  Rev.1.00  Page 25 of 59 

2018.06.28  

このアイコンは、GUIX のロゴのプレースホルダです。ここで、[Pixelmap] リソースから 

[GUIX_LOGO_VERTICAL] をターゲットウィンドウにドラッグし、次の図に示すように、新しく作成したア

イコンに重なるように配置します。 

 

 

図 17   ボタンアイコンへの GUIX ロゴの追加 
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次の図に示すように、ターゲットウィンドウに GUIX のアイコンが表示されます。このアイコンを左上隅に

移動し、アイコンウィジェットの名前を「guix」に変更する必要があります。ターゲットウィンドウで新し

く作成したアイコンをクリックし、GUIX アイコンを左上隅にドラッグします。プロパティビューで、ウィ

ジェットの名前を「icon」から「guix」に変更します。次の図に示すように、最終的なウィンドウが表示さ

れます。 

 

 

図 18   ボタンアイコンに追加した GUIX ロゴ 

同様の方法により、Express Logic のロゴを画面に追加することができます。 
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3.4.3.3 メイン画面への時刻と日付情報の追加（Adding Time and Date info to 

the main screen） 

時刻と日付情報を、テキストウィジェット（text widget）としてメイン画面に追加します。テキストウィ

ジェットを追加するには、ターゲットウィンドウを右クリックし、[insert] -> [text] -> [prompt] を選択しま

す。この結果、次の図に示すように、プロンプト（prompt）が画面に追加されます。 

 

 

図 19   メイン画面へのテキストウィジェットの追加 
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洗濯機アプリケーションの場合、テキストプロンプト (時刻と日付) の背景色を透明、縁は色なし、テキスト

の色を銀色に設定します。時刻プロンプトの位置は、上端中央に調整します。次の図に示すように、プロパ

ティビューで選択肢を変更することで設定できます。 

 

 

図 20   プロパティビューを使用してテキストウィジェットを変更 
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同様の方法で、AM/PM (午前/午後) の選択や、曜日、日付に関連する各種テキストウィジェットを追加する

ことができます。これらのテキストウィジェットを追加した後、次の図の画面のようになります。詳細につ

いては、付属している GUIX Studio プロジェクトとそのプロパティビューを参照してください。 

注記：他のテキストウィジェットの追加は、前述の時刻ウィジェットの追加と同様の方法で実現できます。 

 

 

 

図 21   時刻と日付のテキストウィジェットをメイン画面に追加 
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3.4.3.4 メイン画面へのホームボタンの追加（Adding Home Button to the main 

screen） 

ホームアイコンは、ピクセルマップボタン（pixel map button）であり、ターゲットスクリーンを右クリック

し、[Insert] -> [Button] -> [Pixelmap Button] を選択する方法で追加できます。 

 

図 22   メイン画面へのピクセルマップボタンの追加 
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ピクセルマップリソースから [MENU_ICON_HOME] をドラッグし、ピクセルマップボタンに重なるように配

置します。そのアイコンを画面の右上隅に移動します。この操作により、次の図に示す画面の状態になりま

す。 

 

図 23   ピクセルマップボタンへのホームアイコンの追加 
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3.4.3.5 メイン画面への複数のボタンの追加（Adding Buttons to the main 

screen） 

この章では、洗濯機の機能 (washer)、衣類 (garments)、水位 (water level)、温度 (temperature)、電源オン/オ

フ (power on/off) を選択するためのボタンの追加を説明しています。 

[Washer] (洗濯機) ボタンは、一時停止を意味するアイコンと「pause」(一時停止) という文字を含むピクセル

マップボタンです。このボタンを追加するには、ターゲットウィンドウを右クリックし、[insert] -> [Button] -

> [Pixelmap Button] を選択します。この結果、[Target View] に黄色いボタンが追加されます。[Properties View] 

に移動し、[Normal Pixelmap] フィールドを [BUTTON] に変更し、[Selected Pixelmap] (選択状態のピクセル

マップ) フィールドを [BUTTON_PAUSE_ON] (一時停止状態のボタン) に変更します。また、[Pushed] と 

[Radio] の各フィールドに対応するチェックボックスをオンにします。通常のピクセルマップの代わりに、

選択状態のピクセルマップを表示する方法で、このボタンはプッシュ状態になります。このボタンを[Radio]

に設定したので、このボタンが選択されている状態では、他のいずれのボタンも選択解除されます。Studio 

のボタンバーで、[size to content] (コンテンツに合わせてサイズ調整) をクリックします。この結果、ボタン

は指定したサイズで表示されるようになります。ボタンの配置先である画面の右上隅にこのボタンを移動し

ます。作成済みのアイコンを右クリックし、[Insert] -> [Button] -> [Icon] を選択します。 

 

図 24   ピクセルマップボタンへの [Pause] (一時停止)アイコンの追加 

[BUTTON_ICON_PAUSE]をドラッグし、上の図に示すように、作成したアイコンの手前に配置します。

[pause] (一時停止) プロンプトをボタンに追加するために、ボタンを右クリックし、[insert] -> [text] -> [prompt] 

を選択します。 

プロンプトの [Properties View] で、テキストフィールドを [PAUSE] (一時停止) に変更し、[Transparent] フィー

ルドを選択し、[Border] フィールドを [No Border] (境界線なし) に変更します。[Normal Text Color] に[WHITE] 

を選択します (この色が見つからない場合、色を作成してください)。 

次の図に示す [Properties View] のスナップショットは、[Washer Button] (洗濯機の機能ボタン)、[Pause Icon] 

(一時停止アイコン)、および [Pause Prompt] (一時停止プロンプト) に対応しています。 
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図 25   プロパティビュー – Washer ボタン、Pause アイコン、Washer プロンプト 

 

[Washer] (洗濯機の機能) ボタンに対応するプロパティビューを変更した後、ターゲットウィンドウの 

[Washer] (洗濯機の機能) ボタンは、次の図のようになります。 

 

図 26   メイン画面への [Washer Button] (洗濯機の機能ボタン)の追加 

同様の方法で、他のボタンをメイン画面に追加することができます。個別のボタンのプロパティビューに関

する詳細については、付属している GUIX Studio プロジェクトを参照してください。 
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3.4.3.6 メイン画面への [Washer] (洗濯機の機能) ウィンドウの追加（Adding Washer 

window to the main screen） 

[Washer] (洗濯機の機能) ウィンドウは、メイン画面の子ウィンドウであり、円形のホイール (円形のスライ

ダ) とプロンプトに対応する複数の線で構成しています。これら 2 つのアイコンが重ね合わせで表示され、

[Washer] (洗濯機の機能) ウィンドウを形成しています。各プロンプト線の脇に、洗濯機のさまざまな設定を

表すラベルを表示します。 

 

図 27   Radial Slider (円形のスライダ) コンポーネント 

画面上のスナップショットに、複数のアイコンを表示します。これらは、[Washer] (洗濯機の機能) ウィンド

ウを作成するために、GUIX Studio により重ね合わせが行われます。 

注記：子ウィンドウ ([Washer Window] (洗濯機の機能ウィンドウ)) は、衣類、水位、温度などのボタン選択
状態に応じて着脱されます。洗濯機アプリケーションはこのような方法でアーキテクチャを決定して
いますが、最新バージョンの GUIX Studio のテンプレートを使用することで、さまざまな方法で実装
が可能です。 

 

[Washer Control] (洗濯機の機能制御) インタフェースを作成するには、[Washer] (洗濯機の機能) ウィンドウの

下に 2 種類の異なるアイコンを追加し、子ウィジェットをテキストプロンプトとして追加します。これらの

アイコンに対応する [Pixelmap] は、[Pixelmap] の下にある [Resource] 部の一部として使用できます。ここで

はピクセルマップを追加する詳細な方法は記載していません。ウィジェットを追加する方法については前の

章を参照してください。まだ同時に、このアプリケーションノートに付属している GUIX プロジェクトもあ

わせて参照してください。 
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図 28   作成済みの円形のスライダウィンドウ 

次 の 図 に 、 Radial Slider ア イ コ ン ウ ィ ジ ェ ッ ト （ WHEEL ） と プ ロ ン プ ト ラ イ ン ア イ コ ン

（LINES_WASHER_ON）に対応した [Washer]ウィンドウの[Properties View]スナップショットを示します。 

 

図 29   円形のスライダのプロパティビュー 
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3.4.3.7 メイン画面へのスライドバーの追加（Adding Slider Bar to the main 

screen） 

Slider Bar (スライダバー) は、洗濯の段階を示すためのステータスバーです。スライダバーをメイン画面に追

加するには、[Pixelmap_slider] ウィジェットと[Progress Bar Icon] を使用します。ステータスバーのステータ

ス更新は、描画関数 pixelmap_slider_alpha_draw を使用して制御します。以下に、[Slider Bar] の個別

コンポーネントを示します。 

 
 

図 30  Slider Bar (スライダバー) コンポーネント 

[Pixelmap Slider] と [Status Bar Icon] それぞれのプロパティビューを次の図に示します。詳細については、

GUIX Studio プロジェクトを参照してください。 

 

図 31   スライダバーのプロパティビュー 
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3.4.3.8 メイン画面への画面名の追加（Adding the screen name to the main 

screen） 

ページ名または画面名とは、描画関数 prompt_alpha_draw で作成されるウィジェットタイプのテキスト

プロンプトです。画面を選択したときにスクリーンを動的に更新します。メイン画面の場合、デフォルトの

テキストとして「Washer ON」(洗濯機がオン) が表示されます。 

画面名に対応するプロパティビューを次の図に示します。 

 

図 32   スライダバーのプロパティビュー 
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これまでの章で説明した作成の手順とガイドラインでは、次の図のようなメイン画面を作成することを想定

しています。詳細は、ここまでの説明と参考資料、および GUIX プロジェクトを参照してください。 

 

図 33   ウィジェットを追加した後のメイン画面の外見 
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3.4.4 Garments (衣類) ウィンドウの作成（Creating Garments Window） 

[Garments] (衣類) ウィンドウはメイン画面の子ウィンドウで、[Garments] ボタンの選択/解除により、接続ま

たは接続解除されます。このウィンドウは、前の章で説明した [Washer] (洗濯機の機能) ウィンドウに似てい

ます。このウィンドウには、状態を示すための靴下（Sock）アイコンが内側にあり、コードを使用したアニ

メーションで制御されています。[Garments] (衣類) ウィンドウの作成では、付属の GUIX Studio プロジェク

トの [Washer] (洗濯機の機能) ウィンドウが参考になります。 

[Garments] (衣類) ウィンドウは、メイン画面の子ウィンドウであり、円形のホイール (円形のスライダ) と、

プロンプトに対応する複数の線 (アイコン) で形成されています。これら 2 つのアイコンが重ね合わせで表示

され、[Garments] (衣類) ウィンドウを形成しています。それぞれの線上では、[Garments] (衣類) ウィンドウ

の上に、 [Washer] (洗濯機の機能) のラベルを表すテキストプロンプトが作成されます。次の図に、個別のア

イコンを複数示します。これらは GUIX Studio でテキストプロンプトに重ね合わせ、最終的な [Garments] (衣

類) ウィンドウを形成しています。 

 
 

図 34   Radial Slider コンポーネント 

[Garments] (衣類) ウィンドウを作成した後、次の図に示すスナップショットの画面になります。 

 

図 35   ウィジェットを追加した後の [Garments] (衣類) ウィンドウ 
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[Garments] ( 衣類 ) ウィンドウに対応するプロパティビューを次の図に示します。描画関数 

window_alpha_draw とイベント関数 garments_window_event_function は、ウィンドウの描画と、

[Garments] (衣類) ウィンドウ固有のイベント処理を行います。/src フォルダ内の garments.c を参照するこ

とにより、その機能をより理解することができます。 

 

 

図 36   [Garments] (衣類) ウィンドウのプロパティビュー 

 

 

3.4.5 [Temperature] (温度) ウィンドウの作成（Creating Temperature Window） 

[Temperature] (温度) ウィンドウは、円形のホイール (円形のスライダ radial slider) と、アーチ (青から赤に色

が変移する円弧) を使用して、水の温度を表します。[Temperature] (温度) ウィンドウには、低温から高温ま

での水の温度を表すテキストウィジェットと、実際の水の温度を表す状態ウィジェットが内部にあります。

次の図のように、[Temperature] (温度) ウィンドウを構成するアイコンが複数表示されます。 

このウィンドウは子ウィンドウであり、[Temperature] (温度) ボタンが選択または解除を選択することによ

り、接続または接続解除が行われます。このウィンドウには、コードにより制御されるアニメーションのよ

うなスライダペン (円形の形状) があります。このウィンドウは、2 個のアイコンを重ね合わせ、複数のテキ

ストウィジェットを追加する形で作成します。 

[Temperature] (温度) ウィンドウに対応するプロパティビューを次の図に示します。詳細については、付属し

ている GUIX Studio プロジェクトを参照してください。描画関数 temperature_window_draw とイベント

関数 temperature_window_event_process を理解するためのソースコードが含まれます。 
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図 37   [Temperature Window] (温度ウィンドウ) のコンポーネント 

 

図 38   [Temperature] (温度) ウィンドウのプロパティビュー 
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[Temperature] (温度) ウィンドウは次の図に示すスナップショットのようになります。 

 

図 39   ウィジェットを追加した後の [Temperature] (温度) のウィンドウコンポーネント 

3.5 [Water Level] (水位) ウィンドウの作成（Creating Water Level Window） 

[Water Level] (水位) ウィンドウは子ウィンドウであり、[Water Level Selection] (水位選択) ボタンの状態に基

づいて、接続または解除することができます。[Washer] (洗濯機の状態) または [Temperature] (温度) ウィンド

ウと比較すると分かるように、このウィンドウの外見は異なっています。このウィンドウは、アイコンウィ

ジェットとピクセルマップスライダ（Pixelmap Slider）を重ね合わせてアイコンを完成させる方法で実装し

ます。また、このウィンドウには水位を示すためのテキストウィジェットもあります。 

次の図は、個別のアイコンとピクセルスライダを示しています。 

 

図 40   [Water Level] (水位) ウィンドウのコンポーネント 

[Water Level] (水位) ウィンドウには、イベントを処理するイベント関数 

water_level_window_event_process と、スライダの移動に応じてさまざまな水位を描画するイベン

ト関数 water_level_window_draw があります。 
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この [Water Level] (水位) ウィンドウを作成する際には、個別のウィジェットに関する説明が記された付属し

ている GUIX Studio プロジェクトで参照することもできます。 [Water Level] (水位) ウィンドウに対応するプ

ロパティビューを次の図に示します。 

 

図 41   [Water Level] (水位) ウィンドウのプロパティビュー 

[Water Level] (水位) ウィンドウのすべてのウィジェットを作成した後の最終的な画面を次の図に示します。 

 

図 42   ウィジェットを追加した後の [Water Level] (水位) ウィンドウのコンポーネント 
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3.5.1 作成したプロジェクトから生成するリソースと仕様（Resource and Specification 

files from the created project） 

ここまで、プロジェクトの要求に基づき、GUIX Studio を使用してすべての画面を作成しました。GUIX 

Studio には、リソースファイルと仕様ファイルを生成するためのいくつかのオプションがあります。これら

のリソースファイルは、新しく追加した画面、グラフィックス画像とそのデータ構造体（data structure）、

および関連する描画関数やイベントハンドラ関数があり、ANSI C 形式のコードで生成されます。これらの

リソースファイルと仕様ファイルは、アプリケーションプロジェクトに入力します。リソースファイルと仕

様ファイルは、次の表に示すように、GUIX Studio を使用して生成します。 

 

図 43   リソースファイルの生成 

 

図 44  [Project View] (プロジェクトビュー) 内のリソースファイル 
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生成されたこれらのコードは、アプリケーションコードとともにコンパイルし、ターゲットの最終イメージ

を生成します。洗濯機アプリケーションプロジェクトで使用するリソースファイルと仕様ファイルに関する

サンプルのスナップショットを、上の図に示しています。 

 

3.6 アプリケーションでの GUIX モジュールの包含と設定（Including and 

configuring the GUIX module in an application） 

 [Threads] から [New Thread] をクリックして､新しいスレッドを作成します｡ 
 

 

図 45   新しいスレッドの作成 

 [New Thread] をクリックして､プロパティを表示します｡ 

 [Properties] を以下の内容と一致するように編集します｡ 
 

 

図 46   HMI スレッドのプロパティの設定 

 [Synergy Configuration Window] > [Threads] タブ > [Main Thread Stacks] から、[New Stack] をクリックしま
す。 

注記：新しいモジュールを追加する前に､[HMI Thread] が選択されていることを確認してください｡ 
 

 

図 47   HMI スレッドのスタック 
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 [Synergy Configuration Window]>[Threads] >[HMI Thread Stacks] から、[New Stack] を選択し、タッチパネル
用のフレームワーク sf_touch_panel_I2C を追加します。 

 

 

図 48   タッチパネルフレームワークの追加 

 以下のプロパティを設定します。 
 

    

図 49   タッチパネルのプロパティの設定 

この時点で、Synergy Configurator はメッセージフレームワーク（message framework）と外部 IRQ フレーム

ワーク（external IRQ framework）を作成しています。以下の図に示す外部 IRQ と I2C ドライバスタック（I2C 

driver stack）のプレースホルダを持っていることに注意してください。 

メッセージングフレームワークは、他のフレームワークレイヤやタスクがシステム内でメッセージを渡すた

めに使用します。このシステムは、タッチ入力が発生したときに、タッチスクリーンドライバから HMI ス

レッドにデータを渡すために使用します。 

SF 外部割り込み（SF External Interrupt）は、次の図に示すようにタッチコントローラドライバで使用される

フレームワークレイヤです。 
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図 50   タッチパネルフレームワークのスタック 

 
 [External IRQ Framework on sf_external_irq] を選択し、以下のプロパティを設定します。 
 

 

図 51   外部割り込みのプロパティの設定 

 
 [External IRQ Driver on r_icu] を選択し、新しいモジュールに以下のプロパティを設定します。ヒント: 最

初にチャネルを変更してください｡ 

  

図 52   タッチスクリーンの IRQ プロパティ 

 [Synergy Configuration Window]>[Threads] > [Main Thread Stacks] からで､[Add I2C Driver] を右クリックした
後、[New] -> [I2C Master Driver on r_riic] を選択し､I2C バスのドライバを追加します｡ 

 



Renesas Synergy™ プラットフォーム 高度な GUIX アプリケーション 

R11AN0299JU0100  Rev.1.00  Page 48 of 59 

2018.06.28  

 

図 53   I2C ドライバの追加 

 [I2C Master Driver on riic] で以下のプロパティを設定します。ヒント: 最初にオプションを変更してくださ
い｡ 

 

 

図 54   I2C ドライバの設定 

 Touch Driver の以下のプロパティを設定します。 
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図 55   タッチドライバの設定 

 
 [HMI Thread Stacks] で､[New Stack] > [X-Ware] > [GUIX] > [GUIX on gx] を選択します｡ 
 

 

図 56   GUIX on gx 
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Synergy Configurator は既に GUIX Port on sf_el_gx フレームワーク と Display Driver を作成して、JPEG デコー

ドと D/AVE ハードウェアアクセラレータに対応するプレースホルダが存在する状態にあります。 

 

図 57   GUIX on gx 

 [GUIX on gx] を選択し､以下の [Properties] を設定します。 
 

 

図 58   gx プロパティに対応する GUIX 
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 [JPEG Common] を [Decode Driver on r_jpeg_decode] に追加します。 
 

 

図 59   JPEG 共通モジュール 

 [GUIX Port on sf_el_gx] を選択し､以下の [Properties] を設定します。 
 

 

図 60   sf_el_gx プロパティに対応する GUIX ポート 
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 [JPEG Decode Driver on r_jpeg] を選択し､以下の割り込みプロパティを設定します。優先度 3 は任意であ
ることに注意してください。 

 

 

図 61    r_jpeg プロパティに対応する JPEG デコードドライバ 

 [Main Thread Stacks] から [D/AVE 2D Port on sf_tes_2d_drw] を選択し､以下のプロパティを設定します｡ 

 

図 62   D/AVE 2D ポートのプロパティ 

 [Main Thread Stacks] から [Display Driver on r_glcd] を選択し､以下の [Interrupt Properties] を設定します｡ 

 

図 63   割り込みプロパティ 



Renesas Synergy™ プラットフォーム 高度な GUIX アプリケーション 

R11AN0299JU0100  Rev.1.00  Page 53 of 59 

2018.06.28  

 下にスクロールし、以下の [Graphics Screen 1 Properties] を表示します。 

 

図 64   グラフィックススクリーン 1 のプロパティ 

以下の [Output properties] を設定します。 
 

 

図 65   出力スクリーン 2 のプロパティ 
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 次の図に合わせて、以下の [TCON settings] を変更します｡ 
 

 

図 66   TCON の設定 

 [Synergy Configuration] ウィンドウで [Messaging] タブを選択します｡以下のウィンドウが表示されます。 
 

 

図 67   [Messaging] タブ 

注記：このタブで、タッチスクリーンイベントのイベントクラス定義を設定するほか、イベントキュー
（event queue）を初期化し、変数の関連付けを行います。[Threads] メニューで [Touch Panel Framework 

on sf_touch_panel_I2C] を追加した時点で、タッチイベントが自動的に生成されています。 
 
 [Touch Event] クラスを選択します｡ 

 [Touch Subscribers] メニューで､ [New Subscriber] ボタンをクリックします｡ 
 

 

図 68   [Messaging] タブ 
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 [New Subscribers] ダイアログで､ [HMI Thread] を選択します｡ 
 

 

図 69   [New Subscriber] ダイアログ 

 [OK] ボタンをクリックします｡ 

 キーボードで、Ctrl + s によりプロジェクトを保存します。 

 [Generate Project Content] ボタンをクリックしてプロジェクトファイルを更新します。 
 

 

図 70   プロジェクトコンテンツの生成 

/src フォルダの中に HMI_thread_entry.c ファイルが生成されます。 3.6.1 章で説明したように、アプ

リケーションスレッドから GUIX システムを初期化する必要があります。 

 

アプリケーションスレッド (HMI thread) による GUIX の初期化は、以下のシーケンスで実行します。 

 gx_system_initialize 関数を使用して GUIX を初期化します。 

  g_sf_el_gx.p_api > open を使用して、GUIX ドライバを初期化します。 

 gx_studio_display_configure 関数により GUIX システムを設定します。 

 canvasInit API g_sf_el_gx.p_api > canvasInit により、キャンバスのメモリアドレスを初期化します。 

 gx_studio_named_widget_create 関数を使用してメイン画面を作成し、その画面をルートウィンド
ウ（root window）に接続します。 

 Washer Mode (洗濯機の機能モード) という円形のスライダを作成します。 

 Garments Mode (衣類モード) という円形のスライダを作成します。 

 Water Level (水位) ウィンドウを作成します。 

 Temperature (温度) ウィンドウを作成します。 

 Temperature (温度) という円形のスライダを作成します。 

 gx_widget_show 関数を使用してルートウィンドウを表示し、メイン画面を可視化します。 

 gx_system_start 関数を使用して GUIX システムを起動します。 

 LCD の GPIO 制御を初期化します。 

 PWM ドライバを初期化して開き、TFT パネルのバックライトを制御します。 

 GUI エンジンが制御を引き継ぎ、LCD 画面に画像をレンダリングします。 
 
注記： 詳細については、付属している  Washing Machine (洗濯機 ) アプリケーションプロジェクトの 

HMI_thread_entry.c ファイルを参照してください。 
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3.6.1 画面固有の関数（Screen specific functions） 

各画面に対応するコードは、次の図に示すように、プロジェクトの src/s7g2_pe_hmi1 ディレクトリにあ

ります。個別の画面に対応する以下の関数を処理するコードです。 

 ページの初期化 

 円形のスライダの作成 

 ウィジェットラベルの更新 

 ウィンドウに対応するイベントの処理 

 アイコンの描画 

 特定の角度にアイコンを回転 

 アニメーションの処理 

 ウィンドウのステータス更新 

 

 

図 71   プロジェクトビューで表示した画面固有のファイル 

注記：これらは自動的に生成されるコードではありません。Washing Machine (洗濯機) アプリケーションの
ウィンドウを制御するためのコードを作成する必要があります。 

 

注記：プロジェクトに対応するすべてのコードを作成した時点でそれらのコードをコンパイルし、PE-HMI 

ボードでテストすることができます。 

 

注記：以下の章で説明するように、付属の Washing Machine (洗濯機) アプリケーションプロジェクトをイン
ポートし、ビルドして、PE-HMI ボードでテストすることができます。 

 

4. Washing Machine (洗濯機) アプリケーションの実行 （Running the Washing 

Machine Application） 

4.1 プロジェクトのインポート、ビルド、およびロード（Importing, building and 

loading the project） 

このパッケージに付属する『Synergy プロジェクトインポートガイド』 (r11an0023eu0119-synergy-ssp-import-

guide.pdf) を参照してください。プロジェクトを e2 studio にインポートしてビルドする手順が掲載されていま

す。付属している Washing_Machine.zip ファイルには、完成したプロジェクトが含まれています。 
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4.2 アプリケーションのロードとデバッグ（Loading and Debugging the 

Application） 

 PE-HMI1 の電源を入れ、 J-Link Lite Cortex M debugger を PC と PE-HMI1 に接続します｡ 

注記：この時点で、アプリケーションを対象ハードウェア上で実行する準備が整っていません。アプリケー
ションを実行するには、以下の手順が必要です。 

 [Debug] ドロップダウンメニューをクリックし、デバッグオプションを表示します。 
 

 

図 72  デバッグオプション 

 [Debug Configurations...] オプションを選択します｡ 

 [Renesas GDB Hardware Debugging] から､[Washing_Machine Debug] を選択します｡ 

 [Debug] ボタンをクリックしてデバッグを開始します。 
 

4.3 アプリケーションの検証（Verifying the Application） 

Washing_Machine (洗濯機) アプリケーションをダウンロードし、PE-HMI ボードで実行した時点で、図 3 に

示すようなメイン画面が表示されます。画面の右側に表示されている [Garments] (衣類)、[Water Level] (水

位)、[Temperature] (温度) の各ボタンを順にクリックします。図 2 に示す GUI 形式のさまざまな画面が表示

されます。 

画面の詳細は、3.3 章で説明しています。 

[Washer] (洗濯機の機能) 画面を選択し、以下の機能を使用してさまざまな項目を設定することができます。 

 大きい円の中に、小さい円形のボール形状でアイコンが表示され、Washer (洗濯機の機能) 設定項目を 

[Very Light] (ごく少量) から [Rinse and Spin] (すすぎと脱水) 、まで任意の項目に移動することができま
す。 

 [Wash] (洗濯機の機能) 選択項目である [Medium] (中) または [Quick Wash] (短時間洗濯) にタッチすると、
小さいアイコンが右側の [wash] (洗濯機の機能) 設定項目に移動します。 

 

[Garments] (衣類) ボタンを選択し、[Garment] (衣類) 画面で以下の選択項目を使用して、さまざまな設定を行

います。 

 大きい円の中の小さい円形のボール形状をしたアイコンが、 [Light Colors] (明るい色) から [Workout 

Clothes] (体操着) まで、[Garments] (衣類) の各選択項目へと移動することができます。 

 希望する衣類の選択項目にタッチすると、小さい円形のボールも適切な選択項目に移動します。たとえ
ば、[Denim] (デニム) または [Wool] (ウール) にタッチすると、小さいボールのアイコンが衣類の適切な選
択項目に移動します。 

 

[Water Level] (水位) 画面を選択し、以下の機能を使用してさまざまな項目を設定することができます。 

 大きな [Water Level] (水位) アイコンの中にある [Vertical Slider] (垂直スライダ) を、[Very Low] (ごく低位) 

から [Extra High] (ごく高位) までのさまざまな温度設定項目に移動します。 

 [Water Temperature] (水温) の選択項目である、[Very Low] (低温) または [Extra High] (高温) にタッチしま
す。垂直スライダが、適切な水温設定項目に移動します。 

 

ステータスウィンドウでは、洗濯サイクルの残り時間 (remaining time wash cycle)、水温 (temperature of the 

water)、洗濯する衣類 (garments under wash)、シミュレーションによって求めた洗濯の残り時間  (remaining 

time for the simulated wash) などのステータスが表示されます。 
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5. 次の手順（Next Steps） 

1. renesassynergy.com/kits には、製品サンプルキットである PE-HMII1 に関する詳細や、その製品の『Quick 

Start Guide』(クイックスタートガイド)、設計データ、注文情報、他の役立つアプリケーションプロジェ
クトが掲載されています。 

2. 次の各 URL では、Synergy プラットフォームの 3 つの主な要素に関する詳細を確認し、それらに関連す

るコンポーネントやドキュメントをダウンロードすることができます。 

A. ソフトウェア  :renesassynergy.com/software 

B. ハードウェア  :renesassynergy.com/hardware 

C. ソリューションギャラリー :renesassynergy.com/solutionsgallery 
 

3. 以下の各 URL にアクセスし、以下の要素の詳細を確認します。 

A. マイクロコントローラ :renesassynergy.com/mcus 

B. 開発ツール  :renesassynergy.com/tools 

C. キット   :renesessynergy.com/kits 

6. 参考資料（References） 

GUIX のリファレンスドキュメントとリンクを、以下に示します。 

 『GUIX Studio User’s Guide』：https://rtos.com/solutions/guix-studio/embedded-ui-design-tool/ 

 『GUIX User’s Guide』：https://synergygallery.renesas.com/media/products/1/275/en-US/Synergy_X-Ware_Docs.zip 

 『GUIX™ Synergy Port Framework のモジュールガイド』：https://www.renesas.com/en-

us/software/D6001976.html 

 

SSP とアプリケーションのリファレンスドキュメントとリンクを、以下に示します。 

 PE-HMI1 用 GUIX Hello World アプリケーションプロジェクト 

 → Renesas ホームページ（https://www.renesas.com/ja-jp/）→プラットフォーム→ Synergyプラットフォー

ムで、サンプルプログラム「GUIX "Hello World" for PE-HMI1 - Application Project」を検索してくださ

い。 

 『SSP ユーザマニュアル』：https://www.renesas.com/ja-jp/products/synergy/software/ssp.html 

 Renesas Synergy Knowledge Base：https://en-

us.knowledgebase.renesas.com/English_Content/Renesas_Synergy%E2%84%A2_Platform/Renesas_Synergy_Kno

wledge_Base 

日本語サイト：https://ja-

jp.knowledgebase.renesas.com/Japanese_Content/Renesas_Synergy%E2%84%A2_%E3%83%97%E3%83%A9%E3%

83%83%E3%83%88%E3%83%95%E3%82%A9%E3%83%BC%E3%83%A0 

http://www.renesas.com/kits
http://www.renesassynergy.com/software
http://www.renesassynergy.com/hardware
http://www.renesassynergy.com/solutionsgallery
http://renesassynergy.com/mcus
http://renesassynergy.com/tools
http://renesassynergy.com/kits
https://rtos.com/solutions/guix-studio/embedded-ui-design-tool/
https://synergygallery.renesas.com/media/products/1/275/en-US/Synergy_X-Ware_Docs.zip
https://www.renesas.com/en-us/software/D6001976.html
https://www.renesas.com/en-us/software/D6001976.html
https://www.renesas.com/ja-jp/products/
https://www.renesas.com/ja-jp/software/D6002545.html
https://www.renesas.com/ja-jp/products/synergy/software/ssp.html
https://en-us.knowledgebase.renesas.com/English_Content/Renesas_Synergy%e2%84%a2_Platform/Renesas_Synergy_Knowledge_Base
https://en-us.knowledgebase.renesas.com/English_Content/Renesas_Synergy%e2%84%a2_Platform/Renesas_Synergy_Knowledge_Base
https://en-us.knowledgebase.renesas.com/English_Content/Renesas_Synergy%e2%84%a2_Platform/Renesas_Synergy_Knowledge_Base
https://ja-jp.knowledgebase.renesas.com/Japanese_Content/Renesas_Synergy%E2%84%A2_%E3%83%97%E3%83%A9%E3%83%83%E3%83%88%E3%83%95%E3%82%A9%E3%83%BC%E3%83%A0
https://ja-jp.knowledgebase.renesas.com/Japanese_Content/Renesas_Synergy%E2%84%A2_%E3%83%97%E3%83%A9%E3%83%83%E3%83%88%E3%83%95%E3%82%A9%E3%83%BC%E3%83%A0
https://ja-jp.knowledgebase.renesas.com/Japanese_Content/Renesas_Synergy%E2%84%A2_%E3%83%97%E3%83%A9%E3%83%83%E3%83%88%E3%83%95%E3%82%A9%E3%83%BC%E3%83%A0
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ホームページとサポート窓口 

以下のヘルプとサポートをご活用ください。 

ドキュメント : renesassynergy.com/docs 

ナレッジベース : renesassynergy.com/knowledgebase 

フォーラム : renesassynergy.com/forums 

トレーニング : renesassynergy.com/training 

ビデオ  : renesassynergy.com/videos 
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ご注意書き

1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。お客様の機器・システムの設計におい

て、回路、ソフトウェアおよびこれらに関連する情報を使用する場合には、お客様の責任において行ってください。これらの使用に起因して生じた損害（お客様

または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。

2. 当社製品、本資料に記載された製品デ－タ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許権、著作権その他の

知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うものではありません。

3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。

4. 当社製品を、全部または一部を問わず、改造、改変、複製、リバースエンジニアリング、その他、不適切に使用しないでください。かかる改造、改変、複製、リ

バースエンジニアリング等により生じた損害に関し、当社は、一切その責任を負いません。

5. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図しております。

標準水準： コンピュータ、OA機器、通信機器、計測機器、AV機器、

家電、工作機械、パーソナル機器、産業用ロボット等

高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、

金融端末基幹システム、各種安全制御装置等

当社製品は、データシート等により高信頼性、Harsh environment向け製品と定義しているものを除き、直接生命・身体に危害を及ぼす可能性のある機器・システ

ム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させるおそれのある機器・システム（宇宙機器と、海底中継器、原子力制

御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図しておらず、これらの用途に使用することは想定していませ

ん。たとえ、当社が想定していない用途に当社製品を使用したことにより損害が生じても、当社は一切その責任を負いません。

6. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導体デバイスの使

用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の範囲内でご使用ください。指

定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切その責任を負いません。

7. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする場合がありま

す。また、当社製品は、データシート等において高信頼性、Harsh environment向け製品と定義しているものを除き、耐放射線設計を行っておりません。仮に当社

製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を生じさせないよう、お客様の責任において、冗長設計、延焼対策設

計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての出荷保証を行ってください。特に、マイコンソフトウェアは、単独

での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行ってください。

8. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用を規制するRoHS
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は、一切その責任を負いません。

9. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。当社製品および技術を輸

出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、それらの定めるところに従い

必要な手続きを行ってください。

10. お客様が当社製品を第三者に転売等される場合には、事前に当該第三者に対して、本ご注意書き記載の諸条件を通知する責任を負うものといたします。

11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。

12. 本資料に記載されている内容または当社製品についてご不明な点がございましたら、当社の営業担当者までお問合せください。
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